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Introduction 

 

Welcome to the T-Mobile® webConnect®  

The T-Mobile webConnect Manager software and webConnect service frees you from 

setting up and paying for multiple networks and provides ever-present Internet 

connectivity on T-Mobile’s rapidly expanding 3G network and the T-Mobile HotSpot 

network. 

 Harness the power of the Internet to stay connected—anytime, everywhere on 
the T-Mobile network. Stay connected on your laptop through our EDGE and 3G 
network and Wi-Fi wireless broadband Internet service in convenient locations 
such as home, office or school, Wi-Fi-enabled coffee shops, FedEx Kinko's, 
hotels, airports, and the airline clubs of American®, Delta, United® and US 
Airways®. 

 T-Mobile International is the first mobile communications company to offer 
service on both sides of the Atlantic with a single global brand name and a 
single digital technology standard, GSM (Global System for Mobile 
Communications). One world, one standard, which makes T-Mobile the one 
company that gives customers more ways to stick together. 

 T-Mobile's webConnect Product makes wherever you are the place to be. 

 It just makes sense. The more ways you have to connect with the people who 
matter to you, the easier it is to stay close. 

 The always on T-Mobile webConnect Product and T-Mobile webConnect 
Manager provides a reliable wireless Internet connection with next generation 
speed, so they're great for everything from checking your email, to sharing files 
with friends or co-workers, to enjoying streaming video or sound. You can even 
connect to your corporate network with confidence on a more secure network. 

 Wireless Internet service from T-Mobile HotSpot gives you a world of 
connections that don’t tie you down. With thousands of locations across the 
world — in coffeeshops, hotels, and airports, T-Mobile HotSpots are as easy to 
find as they are to use. 

 With the reliability and expertise of T-Mobile behind you, the webConnect 
experience gives you a connection you can count on. 

 Convenience. The built-in T-Mobile webConnect Manager software installs 
easily on your laptop and auto-finds the fastest available connections for you. 
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 Numerous Options. Take the guesswork out of your connectivity options as the 
T-Mobile webConnect Manager and your T-Mobile's webConnect Product auto-
finds the Internet connection options around you. 

 2-in 1 Productivity. Carry one less device around as the T-Mobile webConnect 
Product can support microSD cards and double as external storage of all your 
documents and downloads such as songs and videos. 

Online Support 

 The Help system is designed to answer your questions on how to perform 
specific tasks and to explain the functions of the T-Mobile webConnect Manager 
. The menu system on the left allows you to browse help topics, while the 
Index and Search tabs provide other mechanisms to access available help 
topics. 

 You can also view the Frequently Asked Questions ( FAQ) page for help at any 
time. 

Contacting Support 

 We're here to help! 

 T-Mobile is committed to your satisfaction when using the T-Mobile 
webConnect Manager solution.   

 The T-Mobile Broadband (2G/3G) online support area is at http:// 
support.t-mobile.com 

 The T-Mobile HotSpot online support area is http:// HotSpot.t-
mobile.com/ support_contact.htm where you will find comprehensive 
technical support and assistance on a wealth of information, including 
troubleshooting tips, FAQs, and configuration settings. 

 You may obtain personal technical support by contacting Customer Support if 
the online help does not address your specific issue. Our trained, courteous 
Customer Service Representatives can quickly help address any questions you 
may have. 

 T-Mobile HotSpot Customer Service and T-Mobile Broadband technical support 
is available 24 hours a day, seven days a week, to assist you. 

 For T-Mobile HotSpot technical support: Call 1.877.822.SPOT (7768). 

 For T-Mobile Broadband (2G/3G) technical support: Call 1.800.937.8997. 

 For customer service on all other T-Mobile products: Visit http:// 
www.t-mobile.com/ Contact.aspx 

http://support.t-mobile.com/
http://support.t-mobile.com/
http://hotspot.t-mobile.com/support_contact.htm
http://hotspot.t-mobile.com/support_contact.htm
http://www.t-mobile.com/Contact.aspx
http://www.t-mobile.com/Contact.aspx
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T-Mobile webConnect Manager License 

When you install T-Mobile webConnect Manager , you have a license to install and use 

the software with T-Mobile's webConnect Product. 

2009-11-16 14:25:55  
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Getting Started 

System Requirements 

The system requirements for basic installation and operation of the T-Mobile 

webConnect Manager software are shown in the table below. 

  Mac OS v10.4.11 (Tiger) Mac OS v10.5 (Leopard) 

Processor 
Power PC G3, G4 or G5 
Processor 
(700 MHz or faster) processor 

Intel or Power PC G5 or G4 
(867 MHz or faster) processor 

RAM 256 MB 512 MB 

Hard Drive Space 60 MB 60 MB 

Compatible OS 
System Updates 

10.4.11 10.5.6 

Safari Version 2.x (or higher) Version 2.x (or higher) 

   

Additional Requirements: 

T-Mobile webConnect Product 

This version of T-Mobile webConnect Manager supports the Huawei UMG 1831 (USB 

Modem). 

See also: 

Inserting a SIM Card 

Wi-Fi 

This version of  T-Mobile webConnect Manager monitors your Mac computer's AirPort 

for Wi-Fi connections. 

See also: 

How to Connect to a T-Mobile Hotspot 
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Inserting Your SIM Card 

Your T-Mobile webConnect Product uses a SIM (Subscriber Identity Module) card that 

contains your account information for the mobile network. Insert your SIM before 

attempting to use the device with the T-Mobile webConnect Manager software.  

The SIM card uses contact points to connect with your device’s modem. You must take 

care not to damage the contact point. 

The orientation notch is used as a reference for properly inserting the SIM card. 

Inserting the SIM card incorrectly will prevent the device’s modem from 

communicating with the network. 

See your T-Mobile webConnect Product Quick Start Guide for more details on the T-

Mobile webConnect Product. 

 

 

Installing the T-Mobile webConnect Manager Software 

Installing T-Mobile webConnect Manager is easy. Connect the T-Mobile webConnect 

Product to your laptop and the installation program will launch automatically. Follow 

the on screen instructions for installation and configuration of the T-Mobile 

webConnect Manager Software. 

Opening T-Mobile webConnect Manager  

To start T-Mobile webConnect Manager follow these steps: 

1. Select Go from the top menu bar 

2. Next, select Applications. 

3. Double-Click on the  T-Mobile webConnect Manager application to open the 

application. 
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The Dock Icon 

When T-Mobile webConnect Manager is first launched, the main screen appears and 

an icon    appears in the Dock. 

Click this icon to open the Main Window of the T-Mobile webConnect Manager 

application. You may also Control-click on the icon in the dock to bring up a short 

menu that allows you to access various tools in T-Mobile webConnect Manager . 
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The T-Mobile webConnect Manager Mobile Interface 

The Main interface for establishing broadband wireless connections is shown below.  

 

 

This window will display details about the T-Mobile broadband network or about one 

of our partner networks when you are roaming. You can do the following from this 

window: 

 Connect or Disconnect to the displayed network by clicking the 
Connect/Disconnect button 

 View data usage by Clicking on the Usage Meter button. 

 View data used during the current billing period in the lower left corner of the 
window. 

Initially this field will show "Usage Setup" until you have configured the usage 
meter. Clicking on the "Usage Setup" indicator will launch the Usage Meter. 

 View the status of the current connection in the Connection Status text field. 

 View how long you have been connected for the current session in the 
Connection Timer field. 

 View the SMS message indicator for new messages. Clicking on the icon will 
launch the SMS client. 

 View the currently used technology type with the Technology Indicator. 
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 Create and edit network profiles by clicking on the Profiles button. 

 Switch to the Wi-Fi mode by selecting the Wi-Fi tab on the right side of the 
main window. 

 Switch to the Mini-View by Clicking on the Min-View button in the upper right 
corner of the Main Window. 
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The Main interface for monitoring Wi-Fi based wireless connections is shown below. T-

Mobile webConnect Manager monitors the Wi-Fi connection established by your Mac 

computer's AirPort application and displays the status of that connection.  

 

 

 

This window will display details about the network you are currently connected to. 

You can do the following from this window: 

 View the displayed network (if any) in the Connection Status field. If you are 

not currently connected, it will this field will display "Not Connected to 

Managed Wi-Fi". 

 Switch to the Broadband mode by selecting the Broadband tab on the right 
side of the main window. 

 Switch to the Mini-View by Clicking on the Min-View button in the upper right 
corner of the Main Window. 
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T-Mobile webConnect Manager Menu 

About T-Mobile webConnect Manager  

Selecting this item will display a window with Serial Number, Version and Technical 

Support information. Clicking on the System Info button will display your Mac 

computer's system information. This information may be helpful when communicating 

with technical support. This item appears on the menu bar of your computer which is 

located at the top of your screen. 

Preferences 

Selecting this item will display the Settings window. Various preferences for T-Mobile 

webConnect Manager may be changed here. 

Hide T-Mobile webConnect Manager  

Selecting this item will hide the T-Mobile webConnect Manager application from your 

screen. An icon will remain in the dock. This is useful if you want to keep the T-

Mobile webConnect Manager available without terminating an active Broadband or Wi-

Fi connection. 

To return to T-Mobile webConnect Manager , click on the T-Mobile webConnect 

Manager icon  in the dock. 

Also, if Show Status in Menubar is checked on the Client tab of the Settings window 

there will be a small icon  in the Menubar. Clicking on this icon and selecting the 

option to Show the T-Mobile webConnect Manager will show the application again. 

Quit T-Mobile webConnect Manager  

Select this item to quit the T-Mobile webConnect Manager application. 
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Controls for the Main Window 

 

The buttons in the upper-left corner of the main window; control the appearance and 

location of the window. 

 

Click this button to Close the main window and exit the application. 

 

Click this button to Send the application to the Dock. 

 

Click this button to Maximize or Minimize the window. 

  

Mini-View 

Clicking on the Mini-View button in the upper right corner of the main window will 

reduce the size of the main window to a miniature window as shown below: 

 

 

Mini-View Broadband Mini-View Wi-Fi 
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The File Menu 

The File menu options available from the menu bar are as follows: 

My Account 

Selecting this item opens a mini browser window that takes you to the My T-Mobile 

Account Management web page, where you can view your account information. You 

will need to log-in to see your account information. 

The webConnect data plan includes unlimited access on the T-Mobile HotSpot 

network. Your HotSpot Account includes a username and password. Your T-Mobile 

HotSpot username is your 10 digit phone number. Your default password is the last 4 

digits of your SSN (Corporate customers, your default password is the last 4 digits of 

your corporate tax ID). You may use Account Management to change your password. 

Your username may not be changed. 

The Tools Menu 

Clicking Tools in the menu bar produces a menu with the following options: 

Network Info> Wi-Fi Network 

Select this item to open the Wi-Fi Info window. This window displays some technical 

information about the Wi-Fi network you are connected to and your current Wi-Fi 

device. 

Network Info> Broadband 

Select this item to open the Mobile Info window. This window displays some technical 

information about the broadband network you are connected to and your current 

broadband device. 

Profiles 

Select this item to open the Network Profiles main window. 

Usage Meter 

Select this item to launch the Usage Meter. 
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Lock SIM 

This item is only available when the Broadband tab is selected on the right side of the 

Main Window. Locking your SIM can be used to prevent use of your T-Mobile 

webConnect Product by anyone who does not know your unique PIN code. 

 Select Lock SIM to lock your SIM card using your PIN code. SIM Locking will then 

be enabled upon the next device reset (after removing and reinserting the 

device). A checkmark will appear on the menu item. 

 Select Lock SIM to unlock your SIM card using your PIN code. SIM Locking will 

then be disabled. The checkmark will be removed from the Lock SIM menu 

item. 

Change PIN Code 

This item is only available when the Broadband tab is selected on the right side of the 

Main Window. Select this item to change the current PIN code on your T-Mobile 

webConnect Product SIM card. 

User Credentials... 

Selecting this item will display a window requiring you to enter your username and 

password for your T-Mobile HotSpot account. This item is only available when the Wi-

Fi button is selected on the right side of the Main Window. 

Always on Top 

Selecting this item ensures that T-Mobile webConnect Manager will always be on top 

of all other applications. 

Transparency 

This menu item connects to a sub-menu where you can select a transparency value for 

T-Mobile webConnect Manager. Values are: Solid, 20%, 40%, 60% and 80%. 



Printed Documentation 

16 

The Help Menu 

Clicking Help in the menu bar of T-Mobile webConnect Manager 's Main window 

produces a short menu with the following options: 

Search 

Enter a term in the Search field to find related menu items and help topics. 

Help 

Opens this Help system. 

Online Forums 

Selecting this item opens your default browser to the T-Mobile Forums web page, 

were you can ask questions, share tips and get helpful info from the T-Mobile 

community. 
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Establishing Broadband Connections 

How to Connect to a T-Mobile Broadband Network 

Before you begin, you will need: 

 The T-Mobile webConnect Product that you will use to establish connections. 

 A T-Mobile webConnect data plan. 

 A network profile configured to access the T-Mobile network. A profile for the 
T-Mobile webConnect Product is initially pre-configured. 

To connect to a T-Mobile Broadband network follow these steps: 

 

1. Insert your T-Mobile webConnect Product if you have not already done so. 

2. Click on the Broadband button in the Main window. If your device is properly 

connected and configured, the T-Mobile webConnect Manager will begin 

searching for an available network. When T-Mobile webConnect Manager is 

ready, it displays Ready to Connect along with the current network profile. 

3. Click CONNECT. 

To view information about your laptop, cellular modem, cellular network connection, 

and session activity, select Tools>Network Info>Broadband. The Mobile Info window 

will appear providing useful information on your laptop and T-Mobile webConnect 

Product. The mobile number (phone number) is listed on this window as well. 

The window includes two tabs: 

 Network 

 Device 
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Network Info: Device Tab 

This tab contains detailed information about your device as provided by the driver 

installed on your computer. Note that if the driver does not provide any information 

or provides incorrect information, that will be reflected in the appropriate field. 

Device Name 

This field displays the name of the device. 

OS 

The operating system that is currently installed on your computer. 

Modem Port 

The communications port located in /dev mountpoint. 

Manufacturer 

The name of the manufacturer of your wireless device. 

Modem Model 

The model name of your wireless device 

Hardware Version 

The hardware ID of your wireless device. 

Driver 

The version of the driver for your wireless device that is currently installed on your 

computer. 

Firmware Version 

The version of your wireless device's on board operating software. 

Serial Number 

Your wireless device's serial number. 
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IMSI 

A GSM mobile subscriber's SIM is assigned a unique 15 digit IMSI (International Mobile 

Subscriber Identity) code. This IMSI allows any mobile network to know the home 

country and network of the subscriber. 

ICCID 

Integrated Circuit Card ID (ICCID) - 19 or 20-digit serial number of the SIM card. 

IMEI 

International Mobile Equipment Identifier: A number string uniquely identifying a GSM 

device. 

Phone number 

The telephone number of your cellular device. 
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Network Info: Network Tab 

The Network tab contains information about the Broadband network you are currently 

connected to (if any). 

Network type 

The type of Broadband network you are currently connected to. 

Network name 

The name of the Broadband carrier you are currently connected to. 

Signal strength (%) 

The strength of the signal being received from this network, expressed as a 

percentage of a maximum possible signal strength. 

Signal strength (dBm) 

The strength of the signal being received from this network, expressed in dBm. 

APN 

Shows the name of the wireless access point with which your Broadband device 

communicates when connected to this network. 

Country 

The country in which the network access point is located. 

Status 

Indicates whether you are currently connected or disconnected. 

Data sent 

The amount of data sent over this connection since it was established (in bytes). 

Data received 

The amount of data received over this connection since it was established (in bytes). 
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IP Address 

The IP address you are using for the current mobile broadband connection. Ordinarily, 

the address displayed here is assigned only for the duration of the current connection. 

It is most likely NOT permanently assigned to your computer. 

Gateway address 

The address of the default gateway that has been assigned to your device. 

Primary DNS 

The address of your primary domain name server. 

Secondary DNS 

The address of your secondary domain name server. 
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GSM PIN Entry 

Some GSM devices will be provisioned with a Personal Identification Number (PIN) 

locking user access to the GSM device. When users insert (or connect) a GSM device or 

and/or launch T-Mobile webConnect Manager , they may be presented with the 

following PIN entry dialog box: 

 

GSM providers frequently limit the number of incorrectly entered PINs. This usually 

ranges from three (3) to ten (10) possible PIN entry attempts. If a user fails to enter a 

correct PIN within the number of permitted attempts, the GSM device may become 

locked. 

 

In the event that a GSM device becomes locked, the user has the ability to re-enable 

the PIN mechanism by entering a Personal Unblocking Key (PUK). If the PIN is locked, 

the user will see the following dialog box where they will have the opportunity to 

reset the PIN by entering a combination of the PUK and the new PIN in the following 

dialog box: 
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SMS 

The Text Messaging Service 

Short Message Service (SMS) is a standard used by Cellular Carriers worldwide for 

interchange of text messages between devices. Originally developed as a GSM 

network technology, SMS messages can be sent using any compatible device. T-Mobile 

webConnect Manager makes sending and receiving text messages simple by using the 

Text Messaging Client. 

The Text Messaging Client 

When connected to a broadband network (Non-Wi-Fi), you can send and receive text 

messages through T-Mobile webConnect Manager very much like you can do on most 

wireless phones. If you have messages waiting you will see the following icons on the 

Main Window for Broadband Connections. 

 

This icon indicates that you have new (unread) text messages. 

 

This icon indicates that you have read text messages in your mailbox (but 
no new ones). 

To view text messages, when the broadband button is selected from the Main 

Window, click the SMS indicator icon (shown above. You will then be presented with 

the Text Messaging Service Window. 

T-Mobile Sent SMS 

T-Mobile may occasionally send an informational SMS message. This type of SMS 

message will appear as a branded popup window and will be on top of other windows 

until the user closes the window or 5 minutes have passed. In the event that a card is 

connected but T-Mobile webConnect Manager is not running and more than one SMS 

message arrives, T-Mobile webConnect Manager will display only the last received SMS 

message. 

  
Example message: 

Free T-Mobile Msg: As of 11:45 AM 12/21 you had less than 1 GB of monthly data usage 

left. Overage is charged at $.20 per MB. Check usage at my.t-mobile.com. 

http://my.t-mobile.com/
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Viewing and Managing Messages 

The Text Messaging Window 

The text messaging client allows you to send and receive text messages using the 

window shown below. This client allows you to view previously sent or received 

messages and send new messages. You can also forward an existing message to a new 

recipient or re-send the message to the original recipient using the buttons on the 

right side of the window.  
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SMS Message Icons 

The following icons appear in the left hand column of the Message List: 

 

An Unread SMS Message 

 

An SMS message that you have already read 

 

A Sent SMS Message 

 

A Forwarded SMS Message 

  

Sending Text Messages 

Before attempting to send or receive text messages, check to make sure that your T-

Mobile webConnect Product is connected to  your laptop and registered with a 

broadband network (T-Mobile webConnect Manager will indicate Ready or 

Connected). 

 

T-Mobile webConnect Manager can send text messages 
when the application is in Ready to Connect mode or 
when you are actively connected. Some networks, 
however, may not support sending and receiving text 
messages while you are actively connected. 

  

T-Mobile webConnect Manager supports sending the following types of text messages: 

 Mobile to Mobile: 
In the number entry field, type the mobile number of the person you are 
sending a message to. For example: Enter ‖8155551212‖ in the number entry 
field of the text messaging client. 

 Mobile to email: 
If your cellular provider supports sending text messages to email addresses, you 
can type the email address of the message recipient in the number entry field. 
Your message will appear as a normal email to the recipient. 
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To send a text message, do the following: 

1. Click on the SMS icon   on the Main Window for Broadband Connections. 

The text messaging window will be displayed. 

Type the mobile number or email address of the person you wish to send a message to 

in the number entry field, next to the To button. 

2. Type your message in the compose text field below the number entry field. 

3. Click Send. 

Did You Know? 

For your convenience, phone numbers can be stored in your Mac computer's address 

book. To access your address book from the Text Messaging Window click on the To 

button or the Address Book icon. 

 

Double clicking on any entry in your address book will add that entry to the number 

entry field. You may also add multiple entries. 

Clicking on the Clear button will delete all text in both the compose text field 

and the number entry field. To delete the text in only one of these fields 

pressing Command + A will select all text in the selected field and then pressing 

delete will clear the field. 
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Receiving Text Messages 

When you receive a text message, the text messaging indicator will appear on the 

primary broadband user interface. 

 

This version of the icon indicates that you have new (unread) text 
messages. 

 

This version of the icon indicates that you have text messages in your 
mailbox (but no new ones). 

Click on this icon to view your messages. 

Updating Text Messages 

If your T-Mobile webConnect Product is connected to your laptop, T-Mobile 

webConnect Manager will automatically retrieve new messages from the device when 

it is launched. You can also update the contents of your Inbox by clicking the Check 

New Messages button. 
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Establishing Wi-Fi Connections 

How to Connect to a T-Mobile HotSpot 

To connect to a T-Mobile Wi-Fi network, use your computer's AirPort.  T-Mobile 

webConnect Manager monitors connections made by your computer's AirPort. Once T-

Mobile webConnect Manager sees a valid T-Mobile Hotspot or Roaming partner, it will 

use your username and password to logon to the Hotspot.  Once you have successfully 

logged onto the Hotspot, the T-Mobile webConnect Manager will display the name of 

the network you are connected to. Your user credentials are entered in the User 

Credentials Dialog which may be accessed from the Tools menu on the main window. 

If the you have saved your credentials, future connections will authenticate using the 

saved credentials and you will not be prompted. 

In order to connect to the T-Mobile Network you must know the SSIDs that are part of 

the T-Mobile network.  The following list of SSIDs is valid as of August, 2009. 

SSID Network Name 

tmobile T-Mobile WiFi Network 

attwifi T-Mobile HotSpot Roaming Partner- AT&T  WiFi 

0033 NTT Com - T-Mobile HotSpot Roaming Partner 

BTOpenzone British Telecom - T-Mobile HotSpot Roaming Partner 

Air-LAN Munich Airport – T-Mobile HotSpot Roaming Partner 

frankfurt-airport Frankfurt Airport – T-Mobile HotSpot Roaming Partner 

T-Mobile_T-Com T-Mobile Europe - T-Mobile HotSpot Roaming Partner 

tcom T-Mobile Germany - T-Mobile HotSpot Roaming Partner 

maxis Maxis - T-Mobile HotSpot Roaming Partner 

ACCESS-StarHub StarHub - T-Mobile HotSpot Roaming Partner 
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wifiarea TelecomItalia - T-Mobile HotSpot Roaming Partner 

mobile Swisscom - T-Mobile HotSpot Roaming Partner 

Telstra Telstra - T-Mobile HotSpot Roaming Partner 

STSN iBAHN - T-Mobile HotSpot Roaming Partner 

ibahn iBAHN - T-Mobile HotSpot Roaming Partner 

zum iBAHN - T-Mobile HotSpot Roaming Partner 

orange Orange - T-Mobile HotSpot Roaming Partner 

opti Opti-Fi - T-Mobile HotSpot Roaming Partner 

T-Mobile_ICE T-Mobile Europe - T-Mobile HotSpot Roaming Partner 
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To connect to a T-Mobile Wi-Fi HotSpot follow these steps: 

1. Select a supported T-Mobile SSID from the list of available networks shown on 

your Mac’s AirPort interface. Your computer will establish the Wi-Fi connection 

with the selected network. Once the connection is established and detected by 

the T-Mobile webConnect Manager and recognized as a supported T-Mobile 

Hotspot, you will receive the following prompt asking if you want to connect to 

the T-Mobile Hotspot: 

 

 

2. Click the Connect button to start the authentication process with the T-Mobile 

Wi-Fi network. If you would prefer not to receive this notification message, 

check the box "Do not show this message again." 

3. T-Mobile webConnect Manager will use your username and password to login. 

4. Once you are logged onto the T-Mobile HotSpot, the T-Mobile HotSpot name 

will be displayed on the Main Window for Wi-Fi Connections 

T-Mobile HotSpot customers are able to authenticate to a T-Mobile HotSpot Roaming 

Partner via the User Credentials dialog. 

Unless you have ―Allow simultaneous connections‖ enabled, you will not be able 

to have a Wi-Fi connection and T-Mobile broadband connection at the same 

time. By default this setting is disabled. 

There is no Connect/Disconnect button on the Main Window for Wi-Fi 

connections. T-Mobile webConnect Manager has no control of the Wi-Fi state, it 

does however, report the current status on the Main Window for Wi-Fi Connections in 

the connection status area. 

T-Mobile webConnect Manager will prompt the user to disconnect a mobile 

broadband connection when a Wi-Fi connection is established,  and the "Allow 

simultaneous connections setting is disabled." 
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T-Mobile webConnect Manager does not support connections to Closed Networks. 

  

How to Disconnect From a T-Mobile HotSpot Network 

To disconnect from a Wi-Fi network: 

Go to http://logoff.hotspot.t-mobile.com. 

  

If the AirPort Interface is turned off, or the computer is turned off while the 

application is running, your are NOT logged off of the T-Mobile Network. 

T-Mobile HotSpot Security 

Select T-Mobile HotSpot locations offer you two different networks for connecting to 

the Internet: 

T-Mobile Wi-Fi Network 

T-Mobile's Wi-Fi Network is the T-Mobile standard network for Wi-Fi connections. 

WISPr Authentication Support 

T-Mobile webConnect Manager supports the WISPr interface specification for access to 

all T-Mobile HotSpot roaming partner networks that support T-Mobile's 

implementation of the WISPr standard. 

Association to Partner Networks Without Authentication 

T-Mobile webConnect Manager will automatically launch an Internet browser page for 

manual authentication with these networks. 

http://logoff.hotspot.t-mobile.com/
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Network Info: Wi-Fi Network 

To view information about a Wi-Fi network you are currently connected to or the Wi-

Fi device you are using to connect to that network, select Tools>Network Info>Wi-Fi 

Network from the Tools menu. This produces a window with two tabs. 

The Network tab contains information about the IP Settings for your current Wi-Fi 

connection. 

The Device tab contains information about your current Wi-Fi Device. 

Wi-Fi Network: Device Tab 

This box contains information about the Wi-Fi device you are currently using. Fields 

include the following: 

Vendor Description 

This is the name of your Wi-Fi network interface card. 

MAC address 

The hardware address of the device. MAC (Media Access Control) addresses are pre-

configured by the device's manufacturer and usually cannot be altered. These 

addresses are used for transferring data by hardware-level protocols such as Ethernet 

and 802.11. Higher level protocols such as the TCP/IP protocol suite used by the 

Internet have their own addressing schemes, but still rely on the hardware-level 

protocol for the transfer of data between individual nodes on a network. 

Driver version 

The version of the driver for this device that is currently installed on your computer. 

Firmware version 

The version of the device's on-board operating software. 
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Wi-Fi Network: Network Tab 

This box displays your computer's current network configuration. It includes the 

following information: 

IP address 

The Internet address your computer is using for the current network Wi-Fi connection. 

Gateway 

The address of the device that is responsible for routing all of your network traffic 

onto the Internet. 

DNS Server 

The address of the server your computer is using to translate verbal Internet 

addresses into numerical addresses (and vice versa). 

DHCP Server 

The address of the server that assigned your computer's network configuration for the 

current wireless connection. 

WINS Server 

The address of the server (if any) that your computer is using to find the names of 

computers on a network. 
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Usage Meter 

Data Usage Introduction 

T-Mobile webConnect Manager allows you to monitor your data usage with the Usage 

Meter. The amount of data transferred is expressed in either Kilobytes ( KB), 

Megabytes ( MB), Gigabytes (GB) or Terabytes (TB). The amount of data transmitted 

or received will depend on the type of files accessed. Text files will typically use 

relatively small amounts of data. Graphics files and music files will typically use 

larger amounts of data. Video files will use very large amounts of data. Your usage 

will vary depending on how often you are using the network and the type of 

information being transmitted and received. The type of data plan you have will 

determine how much data may be transferred before incurring additional charges. For 

example, if you are on a 5GB plan, any data transmission over the 5GB limit will incur 

additional charges. You will receive a free SMS Message from T-Mobile when you have 

exceeded your data plan limit. You may also check your usage at my.t-mobile.com. 

Byte 

A Byte is equal to 8 bits. A bit being the smallest unit which represents either a zero 

or one. A Byte can represent 256 states of information, such as a combination of 

letters and numbers or symbols. 

Kilobyte 

A Kilobyte is 1024 bytes. (Approximately 1000 bytes). Text and small graphics files are 

typically in the Kilobyte range. 

Megabyte 

A Megabyte is equal to 1024 Kilobytes. (Approximately 1000 Kilobytes). Graphics, 

video, programs and large text files may be in the Megabyte range. Cumulative data 

over a period of time may be in the Megabyte range. 

Gigabyte 

A Gibabyte is equal to 1024 Megabytes. (Approximately 1000 Megabytes). Video files 

and large program files may be in the Gigabyte range. Cumulative data over a period 

of time may be in the Gigabyte range. 

http://my.t-mobile.com/
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Terabyte 

A Terabyte is equal to 1024 Gigabytes. (Approximately 1000 Gigabytes). Cumulative 

data over a period of time may be in the Terabyte range. 

Data Usage Meter 

T-Mobile webConnect Manager incorporates a Usage Meter  that shows Mobile Data 

Usage. This may be accessed on the main user interface or from the Tools menu. The 

usage meter displays both cumulative and current usage as well as all the client 

events that have been logged. Initially, the Main Window for Broadband Connections 

will show the text "Usage Setup" in the usage meter display. Clicking on this area will 

take you to the Broadband tab of the Usage Meter where you will be prompted to 

select your billing period start date. 

 

Usage Meter: Broadband 

The Broadband tab of the Usage Meter shows both cumulative usage and current 

usage. This information can be grouped by device and carrier using the dropdown 

menus. 

Current Usage 

This window shows the usage for the billing period selected. 

 In the "Show usage for billing period:" dropdown menu select the billing period 
you wish to view. 

 In the "Billing period start date:" dropdown select the billing period day (2-29). 

 In the "Select Your Plan Limit:" dropdown select the plan you are currently 
using. 

 Overage will display in Red and Normal Usage will be displayed in Green. 

  

The total usage displayed here is an approximation of usage on this computer 

excluding any in-progress session and is not used to calculate data charges.  More 

information about data usage is available at: http:// my.t-mobile.com . You can also 

click the "My Account" link (under the File menu) to access your T-Mobile account 

information online. 

http://my.t-mobile.com/
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Cumulative Usage 

Selecting Cumulative Usage displays the total usage since the last time the "Reset 

Counter" button was selected. 

 Clicking on the "Reset Counter" button will cause the start date in the 
graphical display to reset to the current date. 

 Clicking on the "Details" button will display the Advanced window. 

  

The total usage displayed here is an approximation of usage on this computer 

excluding any in-progress session and is not used to calculate data charges.  More 

information about data usage is available at: http:// my.t-mobile.com . You can also 

click the "My Account" link (under the File menu) to access your T-Mobile account 

information online. 

http://my.t-mobile.com/
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Usage Meter: Advanced 

Selecting the Advanced tab on the Usage Meter will display a window of all the client 

events that have been logged. From the Main Window for Broadband Connections, 

select Tools> Usage Meter. In the Usage Meter window click the Advanced tab to see 

the client events that have been logged. The window shown below will appear. 

 

You can do the following in this window: 

 Use the options in the Filter by box to limit the events displayed to a particular 

date range, connection technology or event type. Then click the Update button 

to update the window with the new event data. 

 Check your client event data by viewing the statistics at the bottom of the 
window. 
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Creating and Managing Network Profiles 

Network Profiles are networks that have been installed or have been manually added 

to the Network Profiles network list. 

Creating Network Profiles have the following advantages: 

 You can configure the client to automatically connect to a Network Profile 
whenever that network is available. 

 If the last network you connected to is not available at a particular location, 
the T-Mobile webConnect Manager software will connect to a network from 
your list of network profiles. T-Mobile webConnect Manager come pre-
configured with Wi-Fi network profiles. 

 You can automate steps in the connection process like launching a browser so 
that you don't have to perform these actions each time you connect. 

Moreover, you must have a profile for the following: 

 You cannot connect to a closed Wi-Fi network unless you create a "closed 
network" Network Profile. 

 You must have a network profile for each Broadband network that you wish to 
connect to. 

The default order for Network Profiles is as follows: 

 User Defined Wi-Fi Profiles 

 T-Mobile Wi-Fi Profiles (including T-Mobile @Home Profiles) 

 T-Mobile Broadband Profiles 
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Creating a Profile for a T-Mobile Broadband Network 

Follow these steps to create a Broadband Network Profile. 

1. Select Profiles from the Tools menu of the T-Mobile webConnect Manager 

software. 

2. The Network Profiles window will now be displayed. 

3. Click the Add button. 

4. Select Broadband as the profile type you will add. 

5. Click Add. The General tab is displayed for this profile. The settings on the 

page are largely personal preference (for example, do you want to launch you 

browser upon successful connection?). Configure these as desired. 

6. Click the  Broadband tab . The Broadband page appears. If you are creating a 

custom profile, you will need to enter the correct settings for the network you 

wish to create a profile for (contact the provider of the network for the correct 

settings). 

7. Click Save. 
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Creating a Profile for a Wi-Fi Network 

Follow these steps to create a Wi-Fi Network Profile. 

1. Select Profiles from the Tools menu of the T-Mobile webConnect Manager 

software. 

2. The Network Profiles window will now be displayed. 

3. Click the Add button. 

4. Select Wi-Fi as the profile type you will add. 

5. Click Add. The General tab is displayed for this profile. The settings on the 

page are largely personal preference (for example, do you want to launch you 

browser upon successful connection?). Configure these as desired. 

6. Click on the IP Settings tab. The IP Settings page allows you to configure the 

Internet Protocol (IP) addressing to be used with this Profile. You will not need 

to alter these values unless specifically instructed to by your administrator. 

7. Click on the Wi-Fi tab. . 

8. In the SSID field, enter the broadcast name of the network profile. Note that 

the name entered here must match the SSID (Service Set IDentifier) used by the 

network exactly. 

9. If you are configuring a profile for  a closed network, check This is a non-

broadcast network. 

10. Click Save to save your Wi-Fi profile. 
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Use this window to add a Network Profile and to edit existing Network Profile 

settings.  

 

Profile Icons 

Each profile listed in the Network Profiles window will have only an icon next to the 

name. This icon indicates the technology that this profile uses to establish 

connections. 

 

Broadband 

 

Wi-Fi 
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Profile Properties: Wi-Fi 

This window contains the security settings for Wi-Fi Network Profiles. Follow these 

steps to configure Wi-Fi network security. 

1. In the SSID field, enter the broadcast name of the network profile. Note that 

the name entered here must match the SSID used by the network exactly. 

2. If the network you are configuring is a closed network, check This is a non-

broadcast network. 

Profile Properties: Broadband 

This tab contains the Broadband - specific settings for Network Profiles. 

Service 

The name of the network for which you are creating this profile. If this is a custom 

profile, you can specify the network name here; otherwise the network name will 

have been entered for you (and is not editable). 

Service Type 

Select the type of service provided by this network. For GSM networks, the option 

available is "Packet" for packet data (Broadband type) connections. 

Dialed Number 

The telephone number that your wireless device must dial in order to connect to this 

network. In most cases, the dialed number for the selected network will have been 

pre-entered for you (and will not be editable). However, if no dialed number has been 

entered, you must enter the appropriate number here. If you do not know the 

appropriate information for this network, contact the network provider. 

Access Point Name 

The name of the wireless access point with which your GSM device communicates 

when connected to this network. In most cases, the access point name for the 

selected network will have been pre-entered for you (and will not be editable). 

However, if no access point name has been entered, you must enter the appropriate 

number here. If you do not know the appropriate information for this network, 

contact the network provider. 
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MIP Profile Number 

The number of the MIP profile used. In most cases, the MIP profile number will have 

been pre-entered for you (and will not be editable). However, if no access point name 

has been entered, you must enter the appropriate number here. If you do not know 

the appropriate information for this network, contact the network provider. 

User Info 

Your username and password for this network is entered in this section. 

Profile Priorities 

In the Network Profiles Window, profiles are listed in order of priority. When selecting 

a network to connect to, T-Mobile webConnect Manager will go down the list from top 

to bottom, selecting the first network profile for which all of the following are true. 

 The network described by the profile is available 

 You have a device capable of connecting to the network connected to your 
computer and ready 

 The Connection Options field on the General tab in the profile's configuration 
is set to either "Automatic" or "Prompt" 

Profile priority also determines when T-Mobile webConnect Manager will 

automatically switch from one network to another. If you are connected to one 

network and a higher priority network becomes available, T-Mobile webConnect 

Manager will switch to the higher priority network. 

Changing Profile Priority 

To change the priority of a specific profile, select the profile whose priority you 

would like to change. Then, drag Up or Down to move the profile up or down in the 

list. 
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How to Edit a Network Profile 

Follow these steps to edit an existing network Profile: 

1. Click the Profiles button in the main window of the T-Mobile webConnect 

Manager software. The Network Profiles window appears. 

 

2. In the left pane, select the network you wish to edit. 

3. Click the Edit button. A tabbed interface showing all the user-editable settings 

of the selected profile appears. Depending on the type of profile you are 

editing, the following tabs may be displayed: 

 Wi-Fi 

 Broadband 

 IP 

 General 

Note that if the profile you are editing was created for you by your service 
provider, you may not be allowed to edit some of its settings. If this is the case, 
some of the tabs may not be present for this profile. 

4. Make the desired changes. 

5. Click the OK button when you are finished. 
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How to Remove a Network Profile 

Follow these steps to remove a network from the Network Profiles window: 

1. Click the Profiles button in the main window of the T-Mobile webConnect 

Manager software. The Network Profiles window will now be displayed. 

2. Select the network that you want to remove from the list in the left pane of 

the window. 

3. Click the Remove button. 

4. Click Close to exit the Profile Properties window. 

You cannot remove Profiles that have been pre-configured by your wireless 

service provider. 

Profile Properties: General 

This tab contains settings that apply to all types of Network Profiles. Note that some 

of these options may not be available if you are configuring a profile created by your 

network service provider. 

Profile Name 

Enter a name for this network profile. This is how the network profile will be 

displayed in the Network Profiles window. 

Connection Options 

This setting controls what T-Mobile webConnect Manager will do when it detects the 

network you are configuring. There are three options: 

 Select Automatic if you want the T-Mobile webConnect Manager to 
automatically connect to this network whenever it is detected. 

 Select Prompt me if you want the T-Mobile webConnect Manager to ask you 
whether to connect to this network each time the network is detected. 

 Select Manual if you only want to connect to this network manually (by 
selecting it from the list of networks and clicking Connect). 
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Open Browser Window on Connect 

Check this box  to automatically launch your browser each time you connect to this 

network. If you want the browser to start at a particular web page each time you 

connect to this network, enter the address of the desired web page in the box below. 

Disable IE's Manual Proxy Settings... 

If you normally connect to the Internet through a proxy server (this is common on 

corporate LANs), you may experience difficulty connecting to the Internet with 

Internet Explorer when you are traveling. This is because Internet Explorer is trying to 

connect through a proxy server that is on your home network rather than on the 

network to which you are connected. 

If this is the case, you may wish to disable Internet Explorer's proxy settings while you 

are connected to other networks. Check this box to disable proxy settings while you 

are connected using this profile. 

Profile Properties: IP 

The IP Settings page allows you to configure the Internet Protocol (IP) addressing to 

be used with this Profile. You will not need to alter these values unless specifically 

instructed to by your administrator. 

Profile IP Address 

This top group of settings specifies the IP address that your system will use when 

connected to this network. The default selection, Obtain IP address automatically, 

instructs T-Mobile webConnect Manager to ask the network to assign it an appropriate 

address each time it connects. This is the correct setting for most network profiles. 

However, if the network does not support automatic address assignment, you can 

enter appropriate values manually by clicking Use the following IP address. Contact 

the administrator of the network whose profile you are configuring to obtain 

appropriate values for these fields. T-Mobile webConnect Manager will override 

existing static IP settings while attempting to connect to a T-Mobile  SSID. 

Profile DNS server 

This lower group of settings specifies the address of the name server that your system 

should use to translate names 
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(i.e. "t-mobile.com") to numerical addresses when connected to this network. The 

default selection, Obtain DNS server address automatically, instructs T-Mobile 

webConnect Manager to ask the network to provide the address of a name server each 

time it connects. This is the correct setting for most network profiles. 

However, if the network does not support automatic DNS server assignment, you can 

enter appropriate values manually by clicking Use the following DNS server address. 

Contact the administrator of the network whose profile you are configuring to obtain 

appropriate values for these fields. 
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Using the Location Finder 

How to Update HotSpot Location Data 

To update the HotSpot Location data: 

1. On the main menu click on T-Mobile webConnect Manager, then click 

Preferences, and then click the Updates tab. 

2. You can select to download and install location directory updates 

automatically, manually, or be prompted when one is available.  Prompt me to 

download and install is the default. 

If the Update Settings tab is set to Prompt me to download and install, T-Mobile 
webConnect Manager automatically checks for available HotSpot data. If new 
data is available, a window appears saying that an upgrade is available and asks 
if you want to install. If yes, you are sent to a web page to do the install. 
Clicking Cancel defers this alert until the next time you launch the T-Mobile 
webConnect Manager . 

3. Click OK to trigger an immediate download of the update. 

4. Normal operation of the T-Mobile webConnect Manager continues following the 

successful completion of the download. 

 Your profile and custom settings are kept and are available after an upgrade. 

How to Use the HotSpot Locator 

The HotSpots button opens the T-Mobile HotSpot Locator. You can use the HotSpot 

Locator to find locations by using the Search or Map sections for both domestic and 

worldwide locations. 

You can either: 

 Select a country; a map of the selected country displays. Choose a city to see 
available HotSpots. 

 Select USA, then choose a state to see the available state-wide HotSpots. 

 Enter other search criteria, such as zip code or area code, and then click 
Search to find available HotSpots. 

The HotSpot Locator provides you with a list of all available HotSpots worldwide. 
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You can do partial searches by entering the first few digits in the Zip Code or 

Area Code fields. 

T-Mobile HotSpot roaming locations are identifiable by the  next to the location 

name in the Results window. 

 

Click or hover on the  icon from the Locator screen to find out more information 

about the HotSpot. 

Click or hover on the  icon from the Locator screen to find out more information 

about roaming or charges. 

No map is displayed if when displaying locations that are in an area not covered 

by the available maps. In this case the resulting data will be displayed higher up 

in the right pane of the HotSpot Locator. 
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T-Mobile HotSpot Security 

Select T-Mobile HotSpot locations offer you two different networks for connecting to 

the Internet: 

T-Mobile Wi-Fi Network 

T-Mobile's Wi-Fi Network is the T-Mobile standard network for Wi-Fi connections. 

WISPr Authentication Support 

T-Mobile webConnect Manager supports the WISPr interface specification for access to 

all T-Mobile HotSpot roaming partner networks that support T-Mobile's 

implementation of the WISPr standard. 

Association to Partner Networks Without Authentication 

T-Mobile webConnect Manager will automatically launch an Internet browser page for 

manual authentication with these networks. 
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Roaming With T-Mobile webConnect Manager 

Roaming with T-Mobile webConnect Manager and the T-Mobile webConnect 
Product or webConnect Jet 

What is Roaming? 

Roaming lets you access the Internet while traveling away from home, whether 

domestically or internationally. For example, if T-Mobile US customers go to a Wi-Fi 

hostpot in London, they could access the Internet with a wireless connection through 

one of our roaming partner networks. Connection Manager allows you to roam on any 

Wi-Fi network partner for an additional charge, however, EDGE or non-3G roaming 

outside the T-Mobile network is restricted. We cannot guarantee the same speeds or 

performance offered while roaming on other networks, therefore, we have decided to 

restrict it. You can still use Broadband if those connections are available to you in a 

T-Mobile service area, free of charge, but we strongly recommend you leverage the 

fastest available connection such as 3G or Wi-Fi. 

The Terms and Conditions of the roaming location’s network, including its security 

and privacy policies, will apply instead of T-Mobile’s during a roaming session. 

T-Mobile webConnect Manager will automatically identify the network of each T-

Mobile roaming partner and provide the proper credentials to access the roaming 

partner's network. Periodic updates of these roaming partners are accomplished when 

software updates are downloaded to your computer. 

Who Can Roam 

Wi-Fi Roaming requires that you have: 

A T-Mobile webConnect Data Plan which includes T-Mobile HotSpot access or access 

though one of T-Mobile's roaming partners. 

For a list of T-Mobile HotSpot roaming partners, use the HotSpot Locator. 
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Roaming With Wi-Fi 

T-Mobile HotSpot customers can use the T-Mobile webConnect Manager to 

authenticate with a T-Mobile HotSpot Roaming Partner by logging in with their 

assigned Username and Password which is entered in the User Credentials dialog. 

This is accessible from the Tools menu. 

User Credentials Dialog 

T-Mobile webConnect Manager supports automatic authentication for a T-Mobile 

HotSpot through the User Credentials dialog. The User Credentials dialog can be 

accessed from the Tools menu. Select Tools > User Credentials. The following dialog 

will be displayed: 

  

 

T-Mobile HotSpot customers are able to authenticate to a T-Mobile HotSpot Roaming 

Partner via this dialog.  Enter your T-Mobile HotSpot Username and Password and click 

OK to save your information. To save your Username and Password for future logins, 

check the box "Store this password for future logins." To clear the Username and 

Password information click on the Clear button. 

Default Subscriber Realm 

T-Mobile webConnect Manager uses the default realm of " t-mobile.us" for T-Mobile 

U.S. Subscribers.  For example if the Username entered was John, the assumed realm 

would be @ t-mobile.us. 



Roaming With T-Mobile webConnect Manager 

55 

Custom Authentication Realm 

You can override the default realm by providing the realm in the Username field. For 

example if the username entered is "username@otherrealm.com," T-Mobile 

webConnect Manager will send the credentials to the realm "otherrealm.com."   
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T-Mobile webConnect Manager Settings 

The Settings Window 

The "Settings" window allows you to configure the behavior of the T-Mobile 

webConnect Manager software. Among other things, these settings control how the 

client connects to networks, the sounds it produces, when it retrieves updates and 

how it handles conflicting applications. 

Select Preferences from the T-Mobile webConnect Manager menu on the top menu 

bar. 

 

For information on the individual settings tabs, see the following: 

 Client Tab 

 Update Tab 

 Sound Tab 

 Hardware Tab 

 Configure Applications 
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Settings: Client 

The Client tab contains general settings for the T-Mobile webConnect Manager 

software. The following options are available: 

User interface is always on top 

When this box is checked, T-Mobile webConnect Manager will always appear on top of 

other application windows. 

Enable splash screen 

When this box is checked, T-Mobile webConnect Manager will display a splash screen 

while it loads. If you don't want the splash screen to be displayed, remove the check 

mark from this box. 

Automatically run this application... 

When this box is checked, T-Mobile webConnect Manager will be automatically 

launched each time you start your computer. 

Display connection timer 

This box controls whether the connection timer will be displayed in the main window. 

When the box is checked (default), the timer will be displayed. When the box is 

unchecked, the timer will not appear. 

Reset all warning messages 

T-Mobile webConnect Manager provides various warning messages that can be 

disabled if you do not want to see them. For example, the connection software will 

warn you that you will lose network connectivity if you close the application. These 

warning dialogs provide you with a method to turn off the warning. You can turn 

these warning messages back on by pressing the Reset button. 

Available languages 

Select the language you would like T-Mobile webConnect Manager to display.   
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Settings: Hardware 

The Hardware tab is used to configure hardware-related settings for connection 

establishment. The following items can be found on this tab: 

The Device List 

This four column table takes up most of the tab's area. It is a list of all the devices 

connected to your computer that may be used to establish network connections. 

Among other things, you can do the following here: 

 You can enable and disable individual devices. 

 If you have multiple devices of the same type, you can choose which one to 
use. 

 You can configure extended properties for Mobile and Dialup devices. 

 For more information, see The Device List. 

Allow simultaneous connections 

If this box is checked, T-Mobile webConnect Manager will allow you to establish more 

than one connection at a time (for example, you could be connected to both Wi-Fi 

and Mobile concurrently). 

If this box is NOT checked, T-Mobile webConnect Manager will prompt you to 

disconnect before allowing you to establish a second connection. 

By default, allow simultaneous connections is turned off. 

Prompt before switching connections 

The T-Mobile webConnect Manager software can automatically switch to a higher 

priority network if one becomes available. However, since the original connection is 

shut down once the new connection is fully established, this has the potential to 

disrupt any activity that was relying on the original connection. 

If this box is checked, T-Mobile webConnect Manager will prompt you for permission 

to switch networks before it actually does so. 

The Profiles Button 

Click this button to open the Network Profiles Window. 
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Settings: Sounds 

The Sounds Tab allows you to instruct T-Mobile webConnect Manager to play a sound 

when various events occur. It also allows you to specify the sounds that T-Mobile 

webConnect Manager plays. To enable this feature, check the Enable sounds box. 

Once the feature is enabled, the playing of an individual tone can be enabled by 

checking the box that corresponds to the tone you wish to play and then clicking 

Browse to select the sound file that you wish to play. You can specify sounds for the 

following events: 

Connected 

Enables the playing of a tone when T-Mobile webConnect Manager successfully 

connects to a Wi-Fi network. 

Lost Connection 

Enables the playing of a tone when T-Mobile webConnect Manager disconnects from or 

loses its connection to a Wi-Fi network. 

Hot Spot Authentication 

Enables the playing of a tone when T-Mobile webConnect Manager associates with and 

connects to a T-Mobile Hot Spot. 
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Settings: Update 

The Update tab allows you to specify how often (if ever) T-Mobile webConnect 

Manager attempts to retrieve updates to its software and its databases. 

Automatically download and install 

(Default) Select this option to have the T-Mobile webConnect Manager automatically 

download and install the latest software including client executable and all databases 

(with hotspots)  when you are connected to the Internet. 

Prompt me to download and install 

Select this option if you would like T-Mobile webConnect Manager to periodically 

prompt you to download and install product updates. 

Manually download and install 

Select this option if you want product updates to be downloaded only when you 

manually initiate the download process using the Update Now button below. 

Update Now 

Click this button to have to have T-Mobile webConnect Manager check for available 

updates now. 
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Application Launcher 

The Application Launcher is used to setup a list of applications and/or files that can 

be launched when a connection to a network is established. 

Adding an Application 

Follow these steps to add an application to the list in the App Launcher: 

1. In the Client tab of the Settings window, click the Configure Applications 

button. The Configuration window appears. 

2. Click the Add button. 

3. In the Profile Name box, enter the name of the application that you are 

adding. The name entered here will be displayed on the Application Launcher 

configuration window. 

4. Click the Browse button next to the box marked File. 

5. Select the file you wish to add to the list and then click OK. You can use the 

Browse button to search your computer for the file if you don't know the file 

name. 

6. If the application requires any additional parameters to be entered on the 

command line when it is launched, the additional parameters may be entered 

in the Parameters field. 

7. The fields in the Toolbar Settings section are used only by versions of T-Mobile 

webConnect Manager that feature a flyout toolbar from which applications may 

be launched. They are not used by the standard version of the product. 

8. Click OK. 
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Application Configuration Window 

This window allows you to select an application to be added to the Application Bar 

and/or edit the parameters T-Mobile webConnect Manager uses to launch that 

application. The following settings appear in this window: 

Profile Name 

This is the name that will be displayed for this application in the App Launcher 

settings page. 

File / Browse 

To select the application to be launched, do one of the following: 

 Click the Browse button, locate the file you want to launch and then click OK. 

 Type the complete path and filename of the file you wish to launch in the File 
box. 

Note that specifying a file here automatically populates the icon parameters below. 

Parameters 

If you wish to specify any command line parameters to use when launching this file, 

you may enter them in this box. Most applications do not require such parameters to 

launch, but some may use them to configure particular options. See the 

documentation for the application you wish to launch for more information about 

command line parameters the application supports. 

Test 

Click this button if you wish to verify that the application launches correctly. T-Mobile 

webConnect Manager will attempt to launch the specified software with the 

configuration you have specified. 

Toolbar Settings 

The fields in this section are used only by versions of T-Mobile webConnect Manager 

that feature a flyout toolbar from which applications may be launched. They are not 

used by the standard version of the client. 
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Editing the Parameters for a Launched Application 

The parameters used to launch an application are found in the Application 

Configuration window. Follow these steps to edit the parameters in the Application 

Configuration Window: 

1. In the Client tab of the Settings window, click the Configure Applications 

button. The Configuration window appears. Select the application you wish to 

edit. 

2. Click the Edit button. The Application Configuration window appears. 

3. Make any desired changes. 

4. Click OK when you are finished. 

5. Next, click Apply to apply your settings. 

6. Click OK to close the Application Launcher window. 

Stopping an Application from Being Launched 

To stop an application from being launched automatically when you connect to 

certain network profiles, remove the application from the list displayed in the 

Application Launcher. To do this, select the application you want to remove and then 

click the Remove button. 
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Warnings and Error Messages 

For Wi-Fi 

Configuration Warnings 

The following are warnings that may appear during configuration of T-Mobile 

webConnect Manager . 

SSID cannot be blank. Please enter a valid SSID. 

This warning appears if you try to create a new Wi-Fi profile, but forget to enter an 

SSID on the first page of the Wi-Fi profile setup. 

Unable to install T-Mobile webConnect Manager software 

 For installation purposes, you must posses Administrative rights to install T-
Mobile webConnect Manager. 

 Check if your computer meets the minimum requirements. 

  

Connection Errors 

This section contains various errors that may appear during connection with T-Mobile 

webConnect Manager . 

Disconnected from network 

Wait for few minutes before trying to reconnect to the network. If problem persists 

please contact T-Mobile customer care. 

Connection Failed/Invalid HotSpot Username and Password 

If you receive the error "Your username or password is incorrect", go to the User 

Credentials dialog to re-enter the 'HotSpot Username and Password'. 

You have failed to log into this network 

This window appears if you enter your username and/or password incorrectly. 

Unable to contact Login Server at (IP address) 

If the destination server is inaccessible during the authentication, you will receive the 

this message. Please try again later. 
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Your are already logged in 

The computer has already logged in to the T-Mobile network. 

For Broadband 

SIM Card Errors 

Broadband connection failure 

 Check if the SIM is enabled for Broadband service. Contact T-Mobile Customer 
Care to activate it. 

 Contact T-Mobile Customer Care to get roaming activated if connection failed 
because 'Roaming not allowed'. 

 Check if the T-Mobile webConnect Manager displays 'T-Mobile Profile' before 
clicking the 'Connect button'. 

No Broadband coverage 

 Check if the T-Mobile webConnect Product is inserted properly. 

 Check if the SIM is inserted properly. 

Wrong PIN/Wrong PIN2 

You have entered your PIN or PIN2 incorrectly. Enter the correct PIN or PIN2, and 

click OK. 

PIN blocked/PIN2 blocked 

You have entered your PIN or PIN2 incorrectly three times in succession. See your SIM 

user's manual for instruction on unblocking your PIN. 

PUK blocked — contact operator 

You have entered your personal unblocking key (PUK) code incorrectly 10 times in 

succession. Contact your network operator or service provider. 

Codes do not match 

This error occurs when you are trying to changing your security code (or PIN) and the 

two codes entered do not match. You must re-enter the new code again to confirm 

the change. 

Connect Disconnect Warning 

This section contains the warnings that may appear during connection or 

disconnection with T-Mobile webConnect Manager . 
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You are currently connected to a network... 

This warning appears when you try to shut down T-Mobile webConnect Manager while 

you are still connected to the network. 
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Customer Support 

Frequently Asked Questions 

Which Wi-Fi cards do you support? 

T-Mobile webConnect Manager for the Mac OS monitors your Mac computer's Wi-Fi 

connection. Please refer to your Mac computer manufacturer's documentation for 

supported Wi-Fi devices. 

What should I do if my connection drops? 

Try logging in again. If it happens repeatedly, call us at 1.877.822.SPOT (7768) for 

help in troubleshooting the cause. 

I have Bluetooth on my laptop. Will this cause interference and prevent a good 
connection? 

Even though they both use the 2.4GHz frequency range, Bluetooth should not 

interfere with the Wi-Fi connection. Contact your laptop vendor or manufacturer for 

more information. 

Can I roam with T-Mobile webConnect Manager? 

Yes. T-Mobile webConnect Manager supports both domestic and international roaming 

for T-Mobile HotSpot subscribers. Be aware that roaming charges may apply. Please 

refer to the T-Mobile HotSpot Web site for roaming charges. 

How do I get T-Mobile webConnect Manager to stop launching every time I restart my 
laptop? 

To keep T-Mobile webConnect Manager from starting when your computer starts, click 

T-Mobile webConnect Manager> Preferences> Client and remove the check from 

"Automatically run this application on machine startup." 

T-Mobile webConnect Manager connected a network, but why do I keep losing the 
connection? 

This may be due to interference caused by other devices, like cordless phones, 

microwave ovens, and other 2.4GHz band devices. 
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Who can I contact if need assistance with the Connection Manager? 

For T-Mobile HotSpot and Wi-Fi technical support, or call us at 1.877.822.SPOT 

(7768). 

For T-Mobile Broadband (2G/3G) support or call us at 1.800.937.8997. 

New network interfaces have been detected. 

When I connect to the T-Mobile broadband network, I keep seeing the following 

message appear. How can I make it go away? 

 

There are two options. 

1. If you click on "Cancel" it will close the dialog message, but it will appear the 

next time you connect. 

2. If you click on the "Network Preferences" button, it will open the Network 

Preferences windows.  Once the window appears, click on "Apply".  Once this is 

done, the message will no longer be displayed. 
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Technical Support 

T-Mobile is committed to your satisfaction when using the T-Mobile webConnect 

Manager solution. 

T-Mobile Broadband Support 

http:// support.t-mobile.com/ productSelector.html 

T-Mobile HotSpot Support 

http:// support.t-mobile.com/ hotspot.html 

It is helpful to be prepared with the following information: 

 Operating system (i.e. Mac OS v10.4 (Tiger) or Mac OS v10.5 (Leopard) etc. See 

the Mobile Info window topic in this help system). 

 Browser version  (usually found in the Help>About menu. See your browser's 

Help system for more information). 

 Description of the problem you are experiencing. 

Devices Supported 

This version of T-Mobile webConnect Manager supports the Huawei UMG1831 USB 

modem.  

Driver Version:  4.16.00.00 

Firmware Version:  11.823.03.00.420 

See also: 

Inserting a SIM Card 

http://support.t-mobile.com/productSelector.html
http://support.t-mobile.com/hotspot.html
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Troubleshooting 

Why am I being asked for my password when installing T-Mobile webConnect 
Manager? 

If you window requesting that you enter your password, you may not have 

administrative rights on that particular machine. To correct this just enter the correct 

password. If you do not have administrator rights, contact your system administrator. 

Note: If your IT manager has questions, please see the T-Mobile webConnect Manager 

data sheet that fully explains our software and how it works in the enterprise. 

Don't see your issue? Try the FAQ page or contact Technical Support. 

Application Launch Issues 

Application is not visible after launch 

T-Mobile webConnect Manager is designed to launch into the display state from which 

it was last exited. As such, it is possible that the Client will launch directly to its 

minimized state, causing the user to assume that it is not actually running. 

Resolution 

Look in the Dock for the T-Mobile webConnect Manager icon. If that icon is present, 

clicking it will display the main T-Mobile webConnect Manager user interface. In 

addition, holding down the control key and clicking  on the T-Mobile webConnect 

Manager icon in the Dock will raise a menu allowing you to access various menu items. 

Auto launching of T-Mobile webConnect Manager at Startup 

T-Mobile webConnect Manager can be configured to allow the application to 

automatically launch when a computer boots up or when a new user logs into the 

machine. This may (or may not) be the desired functionality for the end user. 

Resolution 

The user can change this behavior of T-Mobile webConnect Manager by selecting T-

Mobile webConnect Manger> Preferences and choosing the Client tab. Check (or 

uncheck) the Automatically run this application at login... box to change the 

autolaunch behavior as desired. 
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Broadband Connection Failure 

1. If you are having problems with failures while trying to connect to the 

broadband network please check the following: 

2. Check if the SIM card is enabled for Broadband service. Contact T-Mobile 

Customer Care to activate it. 

3. Contact T-Mobile Customer Care to get roaming activated if the connection 

failed with the message "Roaming not allowed." 

4. Check to see if the T-Mobile webConnect Manager displays "T-Mobile Profile" 

before clicking the Connect button. 

Disconnected From the Network 

If you receive the message "Disconnected from network" or experience network 

disconnections please wait for a few minutes before trying to reconnect to the 

network. It the problem persists please contact T-Mobile customer care. 

Invalid Hotspot Username 

If you receive the message "Invalid Hotspot Username and Password" please enter your 

Username and Password. This dialog can be accessed by selecting User Credentials 

from the Tools menu. Check the box next to the text "Store this password for future 

logins" if you wish to save the password for future connections. 
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No Broadband Coverage 

If your are experiencing problems with broadband coverage please check the 

following: 

1. Check if the data card is inserted properly. 

2. Check if the SIM is inserted properly. 

Unable to Install T-Mobile webConnect Manager Software 

If you're unable to install T-Mobile webConnect Manager Software, please check the 

following: 

1. Check that the computer meets the minimum requirements. 

2. For installation purposes, you must possess Administrative rights to install T-

Mobile webConnect Manager Software. Users without administrative rights on 

an individual machine will be denied the ability to install software on that 

computer. 

Resolution 

No workaround is possible as the user must have administrative rights to install 
T-Mobile webConnect Manager Software. Contact your IT department. 

 


